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Introduction to MASTERFORM

MASTERFORM for UPS is a “smart” form-filling
wizard created to help you ship hazardous
materials (hazmat) with United Parcel Service
(UPS). It prints two forms: the UPS Hazardous
Materials Shipping Paper (on laser or tractor
printer) and the Shipper’s Certification end-of-day
log.

It also saves your shipment information as
templates that you can use again and again.
MASTERFORM uses a chemical table provided by
UPS and will not allow you to ship outside of UPS
restrictions. This helps ensure that you always
ship safely within UPS and DOT hazmat guidelines.

The UPS chemical table is based on the HM 215-D
table published in the Code of Federal Regulations
Title 49 Department of Transportation.

General features:
• Saves shipment information as reusable

templates

• Automatically generates the end-of-day log

• Optional password protection controls access
to shipment information

• Tracks hazmat training schedules of shippers
to help ensure compliance

• Tracks shipments under multiple UPS account
numbers

• Prevents errors by checking shipments against
UPS limitations
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• Provides chemical table data directly from
UPS, updated throughout the length of your
license

• Make printing easier by allowing the movement
of individual fields in any direction

• Allows proper shipping name edits for flexibility
and accuracy

• Reminds shippers to check the Labels Required
field to prevent returned packages

Figure 1: Click UPS Domestic on the QuickStart menu to
begin the installation.Installing MASTERFORM for

UPS Domestic Edition

1. To begin installation of MASTERFORM for UPS,
place the CD in your CD-ROM drive. The main
QuickStart menu will appear.

2. Click Install MASTERFORM Formpacks. (To
launch the QuickStart menu manually, double-
click Setup.exe in the root of the CD.)

3. Click the UPS Domestic button under Install a
MASTERFORM Formpack (see Figure 1). The
MASTERFORM Installation Wizard will launch.

4. Follow the instructions on your screen and
enter your serial number when prompted. (If
you are installing a demo version, type the
word “Demo” as your serial number. Note:
The demo version will not allow you to print.)

5. Let the Installation Wizard copy all necessary
files, then click Finish when prompted.

If you are installing either the Professional or
Military Edition Suite, you will still have to install
MASTERFORM for UPS separately. Follow the
instructions in Installing MASTERFORM for UPS
Domestic Edition.

If you already have a previous version of
MASTERFORM for UPS installed, you can click
Download New UPS Chemical Table on the main
installation menu to install only the updated
chemical table (this will NOT install the full
MASTERFORM program). This step is not neces-
sary if you are installing a new or updated version
of MASTERFORM for UPS. However, as UPS will
require WorldShip-compatible software effective
January 6, 2003, we recommend that you
update now to MASTERFORM 3.0 to comply
rather than waiting for the deadline.

Download New UPS Chemical Table feature

Professional and Military Edition Suites
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Structure of MASTERFORM

Step 1. Enter Setup Information
 
Step 2. Complete a Shipping Paper
           Screen 1: Shipment Template
           Screen 2: Shipper Information
           Screen 3: Shipment Information
           Screen 4: Proper Shipping Name
           Screen 5: The Chemical Table
           Screen 6: Ground or Air Shipment
           Screen 7: Print Preview
           Screen 8: Print/Save Shipment Template

Step 3. Print the Shipping Paper
 
Step 4. Print the Shipper’s Certification

Domestic or International?

The program previously known as MASTERFORM
for UPS is now called MASTERFORM for UPS
Domestic Edition. The name change is to
distinguish this program from the International
Edition that fills out the Shipper’s Declaration for
Dangerous Goods form for international air
shipments. Call Labelmaster for more info.

Installing 49 CFR regulations
and TSI Hazmat Training

You have the option of installing a free hazmat
training program from the Transportation Safety
Institute (TSI). The Q&A format links to the
relevant text of 49 CFR so you can immediately
check your answers against the regulations.

To install this program, return to the QuickStart
menu and click Install Regulations and HAZMAT
Training. Use the same serial number you used to
install MASTERFORM.

When the installation is complete, open the
training program by clicking Start > Programs >
Masterform Regulations > TSI Hazmat Training.

Figure 2: The TSI Hazmat Training program links directly
to the text of 49 CFR so you can check your answers.

What’s my name & password?

When you first attempt to use MASTERFORM after
installing, you will be asked for a name and
password. The default name and password is
“ADMIN.” Type ADMIN in both the name and
password fields, then click Next to continue.
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New shipping paper design for
laser printers

United Parcel Service has released a new form
design for the hazmat shipping paper. The new
design fits all eight required copies of the form on
a single sheet of standard letter size (81/2 x 11
inch) paper, and prints on a laser printer (inkjet
and bubble jet printers are NOT recommend).
 
Using the new laser form is optional, so
MASTERFORM lets you choose a design at the
beginning of the template wizard. Choose Laser if
you’re using the new form; choose Tractor if
you’re using the original 8-part carbon form. 

Labelmaster does not print or distribute any
United Parcel Service forms.

Where to get forms

MASTERFORM for UPS prints on United Parcel
Service Hazardous Materials Shipping Paper
tractor form #02111408 4/98 W and laser form
#02111412 02/02 W. UPS provides these forms to
contracted hazardous materials shippers.
Labelmaster does not design, create or distribute
these forms.
 
For more information, contact the United Parcel
Service Hazardous Materials Support Center at
1-800-554-9964 or consult the UPS Guide for
Shipping Ground and Air Hazardous Materials.
More information is available online at:
 
http://www.ups.com/using/services/accs/hzm-guide.html

Where to install MASTERFORM

During installation, you will be asked to confirm
the installation directory. The default directory is
C:\MF_UPS. The installation wizard will create a
folder named MF_UPS and put all MASTERFORM
program files in it.

You can change this, if necessary, by clicking the
Browse button that appears on the directory
confirmation screen. You may need to install
to a different drive that has more available disk
space, for example. Unless you need to change the
installation location for some reason, it is recom-
mended that you install to the default, C:\MF_UPS.

NOTE: In MASTERFORM v3.0.2 and later, the
Security Authorization Screen is turned off by
default when you intially install.

If you wish to activate the authorization screen
for security purposes, enter Setup from the main
window and uncheck the box for Bypass Authori-
zation Screen. Click Done to exit and save your
settings. Enabling the authorization screen will
prompt the user for a name and password when
using MASTERFORM.
 
Warning! When the authorization screen is
disabled, all users will have full access to your
shipment information.

If you want to add your own personalized name
and password, press the TAB key at this point
instead of clicking Next. This will open the pass-
word list.  See Security: Defining user names and
passwords for more information.
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Purging WorldShip® hazmat entries will not affect
your templates or certification records in
MASTERFORM.

Step 1: Install the software

You must install MASTERFORM for UPS (v3.0 or
later) before installing UPS WorldShip®. This
manual explains how to install MASTERFORM for
UPS, but you will need to contact United Parcel
Service for help installing the WorldShip® program.
Labelmaster cannot distribute or provide technical
support for the WorldShip® program.

Step 2: Set up the System DSN
connection

The MASTERFORM installation will attempt to set
up the DSN connection automatically. After
installing MASTERFORM for UPS, you will see a
new checkbox option named HAZMAT/DG in the
Options tab of WorldShip® (see Figure 10).

If this option is disabled (grayed out), or if you
get an error message when you try to select it,
you may need to set up your System DSN
connection manually.

To manually set up the System DSN
connection:

1. Click Start > Settings > Control Panel to open
your computer’s Control Panel.

Sending your MASTERFORM
shipments to UPS OnLine®

WorldShip®

MASTERFORM for UPS is now integrated with
United Parcel Service’s WorldShip® software so
that you can instantly send your hazmat shipping
paper data directly to WorldShip®. You must have
MASTERFORM and WorldShip® installed on the
same computer, and you must make sure your
System DSN connection is set up properly.

Main integration steps:

1. Install both UPS WorldShip® and MASTERFORM
for UPS (version 3.0 or later).

2. Ensure your System DSN connection is set up
properly.

3. Create and print hazmat shipping papers with
MASTERFORM for UPS.

4. Indicate hazmat shipments in WorldShip® on
the Options tab of the Shipping screen.

Every time you print a hazmat shipping paper,
MASTERFORM automatically sends all the
information about your hazardous materials
directly to WorldShip®. You don’t have to do
anything differently.

The only difference you will see is that each day
when you open MASTERFORM to begin shipping,
the program will ask if you want to purge the
records you sent to WorldShip® the day before.
If you are finished processing your hazmat
shipments through WorldShip®, you can go ahead
and purge the records.
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Figure 5: Click Add to create a new data source for
HAZMAT.

Figure 6: Highlight Microsoft Access Driver and click Finish.

Figure 4: Double-click Data Sources (ODBC) inside
the Control Panel.

This will open the ODBC Data Source
Administrator. Inside the ODBC Data Source
Administrator, click the System DSN tab (see
Figure 5).

3. Click Add... as shown in Figure 5.

4. In the Create New Data Source window,
highlight Microsoft Access Driver (*.mdb) and
click Finish as shown in Figure 6.

2. In the Control Panel window, double-click Data
Sources (ODBC) as shown in Figure 4. (In
Windows 2000 and XP this can be found one
level deeper in a folder called Administrative
Tools.)
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Figure 8: Find the ExportWS.mdb file, highlight it by
clicking once, then click OK.

7. After you select the ExportWS.mdb file and
click OK, you should now see “HAZMAT” listed
on the System DSN tab of the ODBC Data
Source Administrator. You can now click OK as
shown in Figure 9 to exit. Your DSN
connection is ready to go.

Figure 9: Confirm that HAZMAT is now listed, then click OK.

5. In the ODBC Microsoft Access Setup, type
HAZMAT as the Data Source Name. This must
be in all capital letters, exactly as shown here.
You can enter a description if you like, such as
“My UPS WorldShip Connection.”
(See Figure 7.)

6. Under Database, click Select to specify which
database will be the data source.

Browse to your C:\ drive to find the UPSExport
folder. Inside the UPSExport folder you will find the
file ExportWS.mdb. This file is your data source
and it is installed by MASTERFORM.
(See Figure 8.)

Figure 7: Enter HAZMAT as the Data Source Name, then
click Select to specify a database source file.
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Figure 10: Select one of your shipped materials from the
drop-down list.

After confirming the first material, you can select
two more materials from the drop-down boxes
underneath HAZMAT/DG Reference 2 and
HAZMAT/DG Reference 3.

To return to the detailed HAZMAT/DG Record of
any material, click the Details button found next
to each drop-down box.

Deleting HAZMAT/DG records:

When you next open MASTERFORM, you will see a
message asking if you would like to purge the
hazmat entries you sent to WorldShip® the day
before. If you are finished processing those
shipments, you can purge them from WorldShip®

by chosing Yes when this message appears.

Step 3: Send hazmat shipping paper
data to WorldShip®

In Step 2 you established a connection between
MASTERFORM and WorldShip®. WorldShip® is now
ready to receive your MASTERFORM for UPS
hazmat shipping paper data. Every time you print
a shipping paper in MASTERFORM, the material
information is sent automatically to WorldShip®.

Step 4: Specify a hazmat package in
WorldShip®

After completing shipping papers and sending your
shipment data to WorldShip® simply by printing,
open WorldShip® and click the Options tab on the
Shipping screen.

To specify a hazmat package in WorldShip®:

1. On the Options tab, select the HAZMAT/DG
check box.

2. Click the drop-down arrow on the box directly
underneath HAZMAT/DG Reference 1 to
choose from a list of your shipped materials.
(See Figure 10.)

You can put up to three materials on a shipment.
When you select your first material from the list,
WorldShip® will show you the material details for
you to confirm.
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Support and Resources
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Technical Support and Contact
Information

This manual contains a chapter called
Troubleshooting that may have the answer to
your question. Review the topics under
Troubleshooting and our support web site for
quick answers. If you need to call or e-mail
Labelmaster Technical Support, please be
prepared to reference the product name and
version number you are using. The version number
can be found on the main MASTERFORM menu
when you first open the program.

By Phone
You can call toll-free: 1-888-SERVIN-U
(1-888-737-8468) or 1-800-578-4955 between
8 am and 5 pm Pacific Time if you need immediate
help.

Via E-mail
You can e-mail questions or comments to
techsupport@labelmaster.com. We make every
effort to respond immediately, or at least within
one business day.
 
Online Info
FAQs, tech support bulletins, notices, fixes,
downloads, and other helpful information are
always available at:

http://www.labelmaster.com/techsupport
http://www.labelmaster.com/masterform

Online MASTERFORM  Demo
http://www.labelmaster.com/masterform/ups/files/
MasteForm.ppt
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Hardware Recommendations
Windows 95, 98, NT, 2000, ME (32MB), XP.
Minimum 486 processor, Pentium processor
recommended.
CD-ROM drive required.
64MB hard disk space
Color monitor VGA or better (256 colors
recommended)

MASTERFORM is published by Labelmaster
Software. Labelmaster personnel cannot
provide regulatory or legal advice. Please
consult the Code of Federal Regulations Title
49 and the UPS Guide for Shipping Ground and
Air Hazardous Materials for more detailed
information whenever you ship hazardous
materials. 

Okidata printer support: http://www.okidata.com
or 1-800-OKIDATA

UPS hazmat hotline: 1-800-554-9964

UPS OnLine WorldShip help: 1-888-553-1118

UPS hazmat guidelines: http://www.ups.com/
using/services/accs/hzm-guide.html

MASTERFORM home page:
http://www.labelmaster.com/masterform

Office of Hazardous Materials Safety:
http://www.text-trieve.com/dotrspa  ...or...
http://hazmat.dot.gov

DOT Contact:
U.S. Department of Transportation
Research and Special Programs Administration
Office of Hazardous Materials Initiatives and
Training (DHM-50)
Washington, DC 20590-0001
http://www.rspa.dot.gov
 
1-800-HMR-4922 (1-800-467-4922) or
202-366-4488
 
Labelmaster Software
400 East Pine Street, Suite 210
Seattle, WA 98122
1-800-578-4955
http://www.labelmaster.com/software

Other Contacts:
Lexmark printer support: http://www.lexmark.com
or 1-800-LEXMARK

Labelmaster
5724 North Pulaski Road
Chicago, IL 60646
1-800-621-5808
http://www.labelmaster.com
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Remember:

• We cannot alter any data in a way that would
violate UPS or 49 CFR rules.

• Make sure you select the entry with the
correct packing group from the table. There is
an entry for each packing group and, in many
cases, an entry for each variation on the
proper shipping name.

• You can edit the Proper Shipping Name (at
your own risk) by selecting the Allow Proper
Shipping Name Edits option in Setup.

• You can put additional information in the
Technical Name or Other Required Information
fields.

• The Labels Required field is editable. You can
add or delete information as necessary. If no
labels are required, make sure this field reads
“None.”

• You can enable the Exemption Packaging field
by selecting the Exemption Packaging option
in Setup. This way you can use an exemption
number on your shipping paper even when the
UPS table says that an exemption is not
required (and the field is grayed out).

• You can override quantity limitations and
modify units of measure on Ground shipments.
You will see a warning message if the quantity
you enter exceeds what is listed in the table,
but you will be allowed to continue. To modify
the unit of measure (UOM), select an existing
UOM from the list, then type over it.

Chemical table resources

If you have a problem with the chemical table
data in MASTERFORM, we will make every effort
to correct the issue and send you a new table
immediately.

MASTERFORM for UPS uses chemical table data
supplied by United Parcel Service. The table in
your MASTERFORM should match whatever table
was most recently published by UPS; however,
there may be occasions where UPS publishes
changes immediately after a MASTERFORM
update, rendering the software inaccurate. You
can find the latest UPS table online at:

http://www.ups.com/using/services/accs/hazmat/
table_downloads.html

Sometimes discrepancies occur because we must
reformat the table for use within a software
application. You might therefore see inaccurate
data or experience incorrect restrictions while
using MASTERFORM. If this happens, call
1-800-578-4955 for assistance.

Labelmaster Software is committed to helping you
ship hazmat safely. In most instances, we can
make chemical table changes on the fly and send
you a corrected table the same day. In these
cases, you will be able to continue shipping after
copying a single file into your MASTERFORM
program directory.
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Save the correct file to a floppy disk, writable
CD-ROM, network drive, or even just to your
desktop. After your reinstallation (or new
installation on a new computer), copy the
database into the new installation directory.

With MASTERFORM for UPS Domestic Edition, your
templates are stored in the file named
masterform.mdb. Search your computer for this
file name, or browse to the default installation
directory, C:\MF_UPS.

Addresses
With MASTERFORM for UPS Domestic Edition, your
addresses are stored in the file named
UPSAddress.mdb. Search your computer for this
file name, or browse to the installation directory
(default is C:\MF_UPS). If you have Microsoft
Access, you can import or export from the
address database. See Import Excel or Access
address data to the Address Book and Exporting
addresses from the Address Book for more
information.

File Extensions
If you are looking for these databases and can’t
see the file extension “.mdb”, you do not have
your view of file extensions turned on. This is
simply a Windows option. To turn on your view of
file extensions, simply open My Computer and
choose Folder Options from the View menu.
Click the View tab and make sure the for Hide file
extensions for known file types check box is not
selected.

Managing Templates and
Addresses

To keep your template and address book data
safe through repeated updates, you should
familiarize yourself with the databases that store
this information. Template and address databases
are found inside your MASTERFORM installation
directory.

You must know where MASTERFORM is installed if
you want to work with these databases. If you
aren’t sure, search your computer for the file
name “masterform.mdb.” The location of this file
should be your installation directory.

You will not be able to open your template
database directly; security has been applied to
avoid renaming or modification errors. You can,
however,  e-mail the file to Labelmaster Technical
Support for help. For example, you may find the
database has become corrupted and needs to be
repaired.

Templates
If you are simply installing an update CD over an
existing program, MASTERFORM will detect your
templates and ask if you want to save them. Just
say Yes if you do. However, uninstalling or
deleting the installation folder will permanently
delete your templates as well. You must save the
appropriate database outside of the installation
directory in order to keep templates safe during a
reinstall or to move them to a new computer.
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Getting Started Using
MASTERFORM



41    40

MASTERFORM Setup

MASTERFORM needs to know your UPS account
number, log book number, and option preferences
before you begin shipping. Click the Setup icon on
the MASTERFORM main menu to set up this
information. Figure 11 shows the Setup screen.

Figure 11: Inside Setup you can enter UPS account
information, choose options, and configure reports.

SETUP ACCOUNTS

1. In the Account column, enter your UPS
account number. MASTERFORM can save
shipment information for multiple account
numbers; simply enter all the account numbers
you use in Setup and then select the
appropriate number for each shipment from
the account number drop-down list when
you’re filling out the shipping paper.
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Save template by default

We recommend that you always leave this option
enabled (checked). This option selects the Save
as Template check box in the last screen of the
form-fill wizard. When checked, it protects you
from accidentally exiting MASTERFORM without
saving your shipment as a template by prompting
you for a template name.
 
Allow Proper Shipping Name edits

This option should be used with caution. When
selected, it allows you to change a material’s
proper shipping name. You then run the risk of
making a mistake and violating UPS or DOT
regulations. Please use with caution!

Exemption Packaging

This option allows you to enable the Exemption
Packaging field found on the Ground/Air Shipment
screen where your mass/capacity is entered. If
the field is grayed out, it is because no exemption
number is required by UPS. If you select this
option, it allows you to override the UPS table
information and enter an exemption number anyway.

Also included in Masterform v3.0.1 or earlier:

Print Ahead Mode

When selected, this option allows you to leave
certain fields blank so that you can fill them in
later by hand.

NOTE: As of January 6, 2003, this option can no
longer be used. See p. 61 for more information.

REMEMBER! Always click Done when you leave
Setup to ensure your changes are saved.

2) In the Log # column, enter your UPS log book
number. Each UPS account number must have
a unique corresponding log book number.
These numbers are assigned to you by
Labelmaster Software. If you need a number,
call 1-800-578-4955.

3) The Sequence # column can be left alone.
See How log book numbers work.

CONFIGURE REPORTS

Click the document buttons to specify a printer
and paper size for each. Be sure to click the 
Recommend button for each. This will default to
the settings recommended by Labelmaster. See
General Printing Overview for more instructions.

CHOOSE OPTIONS

Bypass Authorization Screen

This option controls access to the name and
password screen. If security is not an issue for
you, choose this option to avoid having to enter
a name and password each time you use
MASTERFORM. This option is checked by
default in MASTERFORM v3.0.2 or later.

Package Label Warning

This option controls the warning message the
appears whenever you leave the Ground/Air
Shipment screen (where mass/capacity and labels
required are entered). When this option is
selected, the warning will appear to remind you to
double-check the Labels Required field.

This option will be enabled by default when you
install MASTERFORM. If you want to turn the
warning message off, deselect (uncheck) the
Package Label Warning check box.
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When you go to print your certification, you will
need to specify the account number again so that
MASTERFORM knows which set of shipping papers
to pull information from. (See Figure 13.)

Figure 12: Select the account number for this shipping
paper and certification.

When you enter an account number in Setup, it
becomes available in the UPS Account Number
drop-down list. When creating your shipping
paper, the Shipper Information screen will require
you to select an account number from this
drop-down list as shown in Figure 12.

Shipping under multiple
accounts

MASTERFORM can organize shipping papers and
certifications under multiple UPS accounts. Enter
all the UPS account numbers you use, with their
corresponding log numbers, into Setup.

The Setup list of account numbers ties Shipping
Papers to Certifications so that you can ship
under multiple accounts. The sequence number
increments automatically, so you can leave it as
zero to begin with.

See Figure 11 on page 41 for an example of how
multiple account numbers are entered into Setup.
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Security: Defining user names
and passwords

MASTERFORM can store an unlimited number of
user names and their corresponding passwords.
Password protection helps keep unauthorized
personnel from using MASTERFORM to ship
hazmat.
 
To add users to the list:

1. Make sure that you do not have the Bypass
Authorization Screen option selected in Setup.
You must be able to view the Authorization
screen.

2. On the main opening menu of MASTERFORM,
Click the first or third icon to view the
Authorization screen.

3. Type ADMIN in both the name and password
fields.

4. Press the TAB key on your keyboard (do not
click Next). Pressing the TAB key will open up
the list of user names and passwords. Do not
type over the ADMIN or USER example log-ins.
(See Figure 14.)

5. Put your cursor in the first blank line under
Name and type the new user name there.
Press the TAB key again to move your cursor
over to the Password field, then type in the
password that will be associated with that
Name.

Figure 13: When you’re ready to print the shipper’s
certification, specify the appropriate account number in
the Review Packages screen.
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How log book numbers work

The log book number is the number by which UPS
organizes your shipping bill. This number, along
with the Sequence number, appears only on the
Shipper’s Certification. For example, if your log
book number is 123456 and your sequence number
is 05, the first print of this certification will have
12345605-0 in the top left corner.
 
Each UPS account number must have a unique
corresponding log book number. Log book numbers
are assigned by your software provider. If you
need a number, call Labelmaster Software at
1-800-578-4955.
 
If you are shipping under multiple UPS account
numbers, you must have a different log book
number for each account number. When you are
setting up MASTERFORM for the first time, enter
your UPS account numbers and log numbers, but
leave the sequence number field at zero (0). The
sequence number will increment automatically for
each day that you print a certification. The
sequence number can be manually adjusted in
Setup if necessary.
 

Why are my log book numbers repeating?

An electronic log book is 50 “pages” long, as
counted by the sequence number. Every
MASTERFORM for UPS customer receives two
electronic log books for a total of 100 sequential
pages. When your log book reaches a sequence of
100, the sequence number will reset itself back to
one (1).

6. Select the check box under Supervisor if you
want this user to have access to this Name
and Password list.

Anyone with Supervisor status will be able to
enter this list by pressing the TAB key. Those
without Supervisor status will be forced into the
next screen and will not be allowed to view the
Name and Password list.

Figure 14: Enter names and passwords of users in the
Authorization screen.
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Making, naming, and saving
templates

To Save a Template:

After you have gone through the form-fill wizard
step by step, created a form, you can review
the Print Preview and print your document (using
File > Print from the drop-down menu). Close the
Print Preview screen by clicking the X or the
magnifying glass icon in the top right corner, and
follow these steps:

1. After closing the Print Preview screen, the Print
and Save Shipment Template screen will appear.

2. Select the Save as Template check box.

3. Name your template. (A name is required to
save a template, but a description is not. The
description field is optional if you would like to
provide more detailed information for yourself
or other users to reference.)

4. Click Done.
 
If any of the above four steps are not completed,
your template will not be saved. If you click the
Cancel button or the X in the top right corner of
the window, your template will not be saved. You
must give the template a name and click Done.
 
Every time you open MASTERFORM and begin
filling in the screens, you are essentially making a
template. You can save it only after all the
screens are filled in and you have reached the
Print and Save Shipment Template screen.

The sequence number increments once per day
according to your computer’s system date. If your
system date has been tampered with, your
MASTERFORM sequence number can be thrown
off.

You can change the Sequence number
manually inside MASTERFORM Setup if you need
to. Just put your cursor in the Sequence number
field and type over the existing number. Be sure to
click Done to exit Setup and save your changes.
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Name field in the Print and Save Shipment
Template screen.

How do I reenter a saved template?

Reenter a saved template by selecting the
template name from the drop-down list in the
Shipment Template screen and clicking Next.
 
The first screen, titled Shipment Template, is
where you begin a new form. It is also where you
can select a previously saved template for
modification now. (If you are beginning a brand
new shipment, click Next while the Template Name
field is blank or reads <None>.)
 
To enter a previously saved template, click the
down arrow at the right end of the Template
Name field. All saved templates will appear in the
drop-down list underneath <None>. Select the
one you want by clicking on it so that it appears
in the Template Name field. Then simply click Next
to enter the first screen and begin making your
modifications.

The Finish button at the end of the wizard
completes your template and logs it in the
shipment history. Every form you complete with
the Finish button will be logged.
 
How do I delete a template?

Delete templates with the Delete Template button
found on the Shipment Template screen. Select
the template from the drop-down list in the
Shipment Template screen so that its title
appears in the Template Name field. Then simply
click the Delete Template button. Deleting
templates will not affect your collection of
shipper’s certification end-of-day logs.

You are not required to save a template, however.
It is an option available if you would like to save
your information for reuse later.

What is a template?

A template is a set of information needed to
complete one form. It is an electronic version of a
shipping paper that you can reenter, edit, and
reprint at any time.
 
When should I use templates?

Use templates for shipment information that you
use often. You can save time and effort by
keeping this information in a ready-to-use format.
For example, if you ship the same material
repeatedly, you can make a template with that
material, and then simply flip through the screens
making minor changes (such as quantities or
consignee names) and reprinting. This way, you
don’t have to retype the information that never or
rarely changes.
 
What should I name my template?

Name your template whatever will conveniently
identify it for you. For example, if you ship
Acetone in different quantities to many different
locations, you might save templates based on the
most common quantities you ship and name them
Acetone - 12 gal, Acetone - .5 fl oz, Acetone -
3.5 L, etc...
 
Or, if you ship different materials to just one or
two locations, you could name your templates
after the locations.
 
There is always room for more detailed information
in the Description field located directly below the
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After completing each screen, click Next to
continue to the next step. When you arrive at the
Print and Save Shipment Template screen, a Done
button will appear in the bottom right area of the
screen.

The Done button completes your template and
saves any changes you made. If you want to
save a template, you must name the template
and click Done. If you exit MASTERFORM before
clicking Done, your template will not be saved.

You can only save a template at the end of the
form-fill wizard, after you have filled in all the
required fields.

Working with templates

Reenter a saved template by selecting the
template name from the drop-down list in the
Shipment Template screen and clicking Next.
 
The first screen, Shipment Template, is where you
begin a new form. It is also where you can select
a previously saved template for modification now.
(If you are beginning a brand new shipment, click
Next while the Template name field is blank or
reads <None>.)
 
To enter a previously saved template, click the
down arrow at the far right end of the Template
Name field. All saved templates will appear in the
drop-down list underneath <None>. Select the
one you want by clicking on it so that it appears
in the Template Name field. Then simply click Next
to enter the first screen and begin modifying.

Figure 15: Saved templates will appear in the drop-down
list beneath <None>.
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Editing the proper shipping
name (PSN)

By default, MASTERFORM will not allow you to edit
the proper shipping name. However, you can
bypass this setting by selecting the Allow Proper
Shipping Name Edits option in Setup.

To select the Edit PSN option: 

1. Double-click the Setup icon on the main
MASTERFORM menu.

2. Select the Allow Proper Shipping Name Edits
check box.

3. Click Done.
 
Now reenter your template. After selecting a
chemical from the table, you can edit the proper
shipping name field. Editing is only allowed in the
Proper Shipping Name screen after the chemical
has been selected from the table. Make sure you
comply with all 49 CFR and United Parcel Service
rules when editing a proper shipping name.

Note: If you find you still cannot edit the PSN
after selecting the Allow Proper Shipping Name
Edits option, try refreshing the Basic Description
Details screen. Just click Next, then Back again to
refresh the screen; then try again.

See Troubleshooting: Can’t edit the PSN.

Deleting templates

On the first screen, select the template name into
the Template Name field and click Delete
Template.
 
The Delete Template button is found in the
Shipment Template screen (see Figure 15). Select
the template name from the drop-down list in the
Shipment Template screen so that it appears in
the Template Name field. Then click Delete
Template.

Deleting templates will not affect what appears on
your certification.
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Confirming the labels required
for your package

When you move out of the Air or Ground Shipment
screen (where the quantity, exemption numbers,
and labels required are specified), MASTERFORM
reminds you to double-check the labels required
field with the message shown in Figure 16  below.
This helps shippers remember that the shipping
paper must match the labels on the package.

The Labels Required field will be populated with
the label names that appear in the United Parcel
Service chemical table. Often there will be more
than one possible label or you may need to
change this field for other reasons. The Labels
Required field is editable. You can add, delete, or
modify label names as necessary.

With the new WorldShip® integration, the Labels
Required field is limited to 50 characters. If your
label descriptions are too long, MASTERFORM will
tell you that the field exceeds WorldShip® limits.
You may need to abbreviate the label names in
these cases.

Figure 16: You’ll see this message every time you move
out of the Air/Ground Shipment screen.

Using an Exemption Packaging
number

The Exemption Packaging field is found on the
Ground/Air Shipment screen where your mass or
capacity is entered. This field allows you to select
or type an exemption number to appear on your
shipping paper. A brief list of common exemption
numbers is provided, but you can type any
number there as well.

The field is open for materials that are designated
in the UPS chemical table as allowing or requiring
an exemption.

If the Exemption Packaging field is grayed out, no
exemption is required by UPS. You can override
this, however, and enable the field by selecting
the Exemption Packaging option inside Setup.

See MASTERFORM Setup. Figure 11 on page 41
shows the Exemption Packaging option in Setup.
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Pre-printing forms for future
use

NOTE: As of version 3.0.2 of MASTERFORM for
UPS Domestic Editon, Print Ahead Mode is not an
option due to the integration with UPS
WorldShip®. If you wish to continue using the
Print Ahead Mode option until January 6, 2003,
you must use MASTERFORM v3.0.1 or earlier.

If you want to pre-print forms that will be
completed at a later time, select the Print Ahead
Mode option in Setup before creating the
shipment template.  After you select the Print
Ahead Mode check box, click Done to exit Setup
and save your settings.
 
Warning! When selected, this option will disable
the Shipper’s Certification end-of-day log.
Shipments you complete in Print Ahead Mode will
not appear on the certification; you will have to
manually complete a certification for them later.

Turning off the Labels Required
field warning

To prevent returned packages, MASTERFORM
reminds you to check the Labels Required field
before leaving the Ground or Air Shipment screen.

If you don’t need the reminder and want to turn
off the message, you can do so by deselecting
the option for Package Label Warning inside
Setup. Simply click once on the check box to
clear it, then click Done to exit Setup and save
your changes.

See Figure 11 on page 41 to see the Package
Label Warning option in Setup.

See MASTERFORM Setup.
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Features and Options
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Writing notes inside
MASTERFORM

You can leave electronic notes inside
MASTERFORM that are specific to a particular
field.

To write a note:
1. Place your cursor in the field to which the

note pertains.

2. Right-click and choose Note from the pop-up
menu.

3. Type your note inside the yellow note window.

When you finish, simply close the note by clicking
the X in the top right corner. Your text will be
saved automatically. MASTERFORM will place a
checkmark next to the Note menu option to
indicate that a note has been saved on that field.

To read a note:
1. Place your cursor in the field to which to note

pertains.

2. Right-click and choose Note from the pop-up
menu.

You’ll notice that when a note is saved on a field,
the Note menu option has a checkmark next to it
(see Figure 17). When you select a checkmarked
Note menu option, the note will open. To delete a
note, simply erase all the text inside the note and
exit the note window.
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Entering addresses in the
Address Book

To access the Address Book, click the button with
an open-book icon found on both the Shipper
Information and Shipment Information screens.
Figure 18 shows the location of the Address Book
icon on the Shipper Information screen.

Figure 18: Look for the open-book icon on the Shipper
Information and Shipment Information screens to open
the address book.

To add a new address, click Add and then enter
the appropriate information in the fields. Click OK
to save your entry. Then click Select to pull that
entry into your template. (See Figure 19.)

Addresses you enter will be automatically
alphabetized by company name. You can search
for a specific company name or browse through
the addresses by clicking the letter group buttons
at the top of the Address Book window.

Figure 17: A checkmark next to the Note option indicates
that a note has been saved.
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Import Excel or Access address
data to the Address Book

If you have addresses in an Excel or Access table,
you can import them into the MASTERFORM
Address Book database found in C:\MF_UPS\
Exchange.mdb > Tables > upsAddress.

The MASTERFORM address book is controlled by
the Microsoft Access 97 database named
Exchange.mdb. The table that stores address
data is named upsAddress and it is configured
with the following column names. This is what the
columns in your Excel or Access file must match,
in this order:

CompanyName, Address, City, State, Postal Code,
Contact, Phone

Step 1: Prepare your data

(a) Make a copy of your current address database
or Excel table and work off the copy.

(b) On the copy of your address database/table,
modify your data so that MASTERFORM can
accept it: rename your column headings to
match those listed here exactly and delete
any other columns. MASTERFORM will only
accept these columns. For example, an Excel
sheet ready to be imported will be formatted
as shown in Figure 20.

(c) When your addresses are ready to be
imported, open the MASTERFORM database
that stores address data: Exchange.mdb.

To select an address, search for the name or
browse the letter groupings. When you find the
address you want, highlight the name by clicking
once anywhere within the entry. Then click
Select. The address will be pulled into your
template.

Figure 19: Find the address you want, highlight by clicking
once on the name, then click Select.

To edit an address, highlight it and click Edit. To
delete an address, highlight it and click Delete.
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IMPORTANT: The upsAddress table itself should
not be open when you go to import. Make sure
the table is closed but highlighted, then perform
the following steps:

(a) Select Get External Data from the File menu.
You should see two options when you select
Get External Data: “Import” and “Link Tables.”
Select Import as shown in Figure 22.

(b) Browse to find your address data (the file you
want to import). Make sure to change the
Files of Type drop-down list so that you can
see the appropriate files. For example, if your
data is in an Excel worksheet, the Files of
Type field should read “Microsoft Excel.”
Otherwise, you won’t be able to see any Excel
files.

(c) When you’ve found your address data,
highlight the file name by clicking it once, then
click Import. This will bring you into the
Access Import Wizard. (See Figure 23.)

Figure 21: Highlight the table named upsAddress before
importing.

Figure 20: Format your address data into columns with
these exact names.

Step 2: Import your data into the
upsAddress table

A table within the database named Exchange.mdb
controls the Address Book feature of
MASTERFORM. This database sits in your
MASTERFORM installation directory. By default,
the directory is C:\MF_UPS.

You must have Microsoft Access installed on your
computer to open and use the Exchange.mdb file.
If you have Microsoft Access, simply browse to
the installation directory (C:\MF_UPS) and
double-click the file Exchange.mdb.

Inside Exchange, click the Tables tab to find the
table named upsAddress. This is the table that
stores your address data. (See Figure 21.) Again,
it is configured with the following column names:

CompanyName, Address, City, State, Postal Code,
Contact, Phone
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Click Next on the first screen of the import wizard
to continue. On the next screen, make sure the
First Row Contains Column Headings check box is
selected. Then click Next again.

Note: If you import more addresses later, do not
use column headings at all. You will not be able to
import column headings more than once, so these
instructions apply only to your first import.

(d) On the following screen, select the option to
put your data into an existing table and select
upsAddress from the drop-down list as
shown in Figure 24.

Figure 24: Import your data to the existing table named
upsAddress.

Figure 22: Select Get External Data > Import from the File
menu.

Figure 23: The Microsoft Access Import Wizard.
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Exporting addresses from the
Address Book

You can easily export the address data used in
MASTERFORM for UPS to a new Excel file or
Access database. MASTERFORM stores addresses
inside the database named Exchange.mdb, which
sits in the install directory (C:\MF_UPS by
default).

To export addresses from MASTERFORM:
1. Open Exchange.mdb in Microsoft Access 97 or

2000.

2. Highlight the table upsAddress by clicking
once.

3. Choose Save As/Export from the File menu.

Figure 25: Choose Save As/Export from the File menu
inside Microsoft Access.

(e) Click Next to continue.

(f) Confirm that the Import to Table field reads
“upsAddress,” then click Finish. Access will
pull your data into MASTERFORM for UPS.
Open MASTERFORM and make sure your
address data is there.

If you encounter any errors during the import
process, double-check your steps. Make sure the
upsAddress table is not open and your columns
are named correctly, then try again.
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The address data from MASTERFORM has now
exported to a new file. After clicking Export, use
My Computer or Windows Explorer to browse to
the file’s location on your computer.

Labelmaster Technical Support personnel will help
you with importing and exporting, but cannot
provide support for Microsoft Access. Some issues
may require you to upgrade your version of
Access or contact Microsoft for further
assistance.

Figure 27: Specify a location and file type, then click
Export.

4. When you select Save As/Export, you will be
asked how you want to save the table. You
could save a copy of your address data within
Exchange.mdb under another name, but it’s
more likely that you’ll want this information
outside of Exchange. In this case, choose to
save the table to an external file or database
and click OK. (See Figure 26.)

Figure 26: Select how you want to save the table.

5.  Choose a location and a file type in which to
save the table. In the Save as Type field, you
can select different versions of Microsoft Excel
or Access, FoxPro, HTML, Word, and many
other file types.

Specify a location (Save In...), a file name (File
Name:), and a type (Save as Type:), and then
click Export (see Figure 27).
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Saving multiple field values

MASTERFORM allows you to save or “remember” a
value for an individual field. For example, if you
have a standard list of names you want to appear
in the Signature field, you can save them as
remembered values. Then everyone who uses the
program can select those signatures from the
signature field drop-down list rather than retyping
them each time.
 
To remember a value:

1. Type the information you want to save in the
correct field.

2. With your cursor still in the field, right-click
and choose Remember from the pop-up
menu.

 
Type a new value and repeat these steps to
continue adding values to the remember list for
this field.

Figure 28:Right-click inside fields to remember values.

Setting default field values

You can set a default value for an individual field
in the MASTERFORM wizard. A default field value
will automatically appear in the field even when
you begin a brand new template.

For example, if you want to prevent typos in the
Emergency Telephone Number field, you can enter
the number once and save it as a default value.
Then everyone who uses the program will know
exactly what number should appear in that field
and they will not need to remember it and type it
themselves.
 
To set a default field value:

1. Type the information you want to save in the
correct field.

2. With your cursor still in the field, right-click
and choose Set Default from the pop-up
menu.

 

To remove a default field value:

1. Enter a shipping paper and move to the field
with the default value.

2. With your cursor in the field, right-click and
choose Clear Default from the pop-up menu.

See Figure 28 on page 79 (Saving Multiple Field
Values).
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Figure 29: Double-click an entry in the regulation list to
launch the electronic 49 CFR in Reg-Trieve.

Viewing the regulations

MASTERFORM has the option of linking directly to
relevant 49 CFR regulations while you are working
in the program.

However, in order to access the regulation
information, you need to subscribe to one of the
programs in Labelmaster’s Reg-Trieve reference
library. For more information about this convenient
and powerful option, call 1-800-578-4955 to
speak to a sales representative.

To access 49 CFR regulations from inside
MASTERFORM (after installing Reg-Trieve):

1. Open MASTERFORM.

2. Choose Regulations from the View menu.

3. Double-click a reference from the list and wait
for 49 CFR to launch.

You can also right-click in the middle of any
screen and choose Regulations from the
right-click pop-up menu. The regulation
reference list will appear. (See Figure 29.)
Double-click the reference you want from the list.
The electronic 49 CFR will launch.

Once inside the electronic 49 CFR, you can
browse the entire hazardous materials regulations
and perform complex searches to find the
information you need. You can receive free phone
training on using this powerful reference tool by
calling 1-800-578-4955.

The regulation reference list is context-sensitive;
that is, the references you see listed will change
according to what screen you are in. If you find
that the Regulations menu option is grayed out,
move to a different screen and try again. Some
screens do not have any regulatory references
associated with them.
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The Form-Fill Wizard
Step by Step
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Screen 1: Shipment Template

When you double-click the UPS hazmat shipping
paper icon on the main MASTERFORM menu, the
first screen you see is titled Shipment Template.
If you are beginning a brand new shipment, click
Next while the Template field reads <None>. Then
select which form design you plan to use for this
shipment (laser or tractor). Now you can begin
filling in your shipping paper.
 
If you want to use a previously saved template as
a basis for this shipment, choose that template
name from the drop-down list underneath
<None>. MASTERFORM does not come with any
pre-made templates. You create the templates
from your own shipping information.

Figure 30: Choose a template and a form type to begin.
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When you select a UPS Air or Ground service, the
Transport Mode will change. Fill in the necessary
information and click Next to continue.
 

Screen 4: Proper Shipping
Name

When you arrive at the Proper Shipping Name
(PSN) screen, you are ready to select the group
of materials you plan to ship with this template.

You can put up to three materials on one UPS
hazmat shipping paper. See Screen 6 for
instructions on adding more than one material to a
single shipping paper.
 
Click the button with the magnifying glass icon to
look up materials in the table. (See Figure 31.)

Figure 31: Click the magnifying glass button on the Proper
Shipping Name screen to select a material to ship.

Screen 2: Shipper Information

In this screen, enter information about the
shipper; that is, you and your company. A field
name in bold indicates that the field is required.
On this screen the Signature field is the only
optional field. The signature can be written in
later by hand.
 
If your account number is not in the list, cancel
this template and enter your account number in
Setup. See MASTERFORM Setup for more
information.

Screen 3: Shipment
Information

The Shipment Information screen is where you
enter your package reference, the date, the
receiver’s name, city and state, and the UPS
service you will use for this shipment.
 
Enter in the package reference field information
that will identify this shipment in case of an
emergency or problem. This could be a purchase
order number, vendor code, or shipment number,
for example.
 
The receiver’s name and location will not appear
on the hazmat shipping paper because there is no
place for that information on that document. The
receiver information will appear on the Shipper’s
Certification end-of-day log, however.
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Screen 5: The Chemical Table

Once you’ve opened the chemical table, you have
five ways to find the item you want:

1. Type the proper shipping name (PSN) directly
under Basic Description

2. Type the I.D. directly in the I.D. Number field
3. Scroll the alphabetical list of PSNs
4. Scroll the list of ID numbers
5. Click the Lookup button and type the name

Figure 33: Find the chemical you want by Basic
Description or I.D. Number, then click Select.

The Proper Shipping Name screen is where you
can edit the PSN or add a technical name. (See
Figure 32.) You must have the Allow Proper
Shipping Name Edits option selected in Setup
before MASTERFORM will allow you to edit the
PSN. (See MASTERFORM Setup.)

Figure 32: After selecting a material from the table,
modify the PSN as necessary.
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Add up to three materials

If you need to add another material to this
shipping paper, click Add. This will take you back
to the Proper Shipping Name screen where you
can reenter the UPS chemical table and select
another material. You can put up to three materi-
als on one shipping paper. If you don’t need to
add another material, click Finish to view the print
preview and print your form.

Screen 7: Print Preview      

When you click Finish in the Ground or Air
Shipment screen, a print preview of your form will
appear. Take this opportunity to review the
information on the form. When you’re ready to
print, choose Print from the File menu.
 
If you need to correct something on the form, exit
the Print Preview by clicking the preview icon in
the top right corner (see Figure 34 for tractor
preview; Figure 35 for laser preview). This will
hide the preview in the background. Then you can
click the Back button to go back through the form
to the screen you need to edit.

Make your corrections and proceed through the
form again to the Finish button. Click Finish again
to refresh the print preview and view your
corrected form.
 
For  more information about printing, please read
the following sections of this book:

General Printing Overview
Creating a custom paper size (tractor only)

Screen 6: Ground or Air
Shipment

The Ground or Air Shipment screen is where you
enter the mass/capacity of the material you are
shipping. This screen is also where you can
specify exemption packaging numbers and labels
required.
 
Specify Labels Required, Exemption
Packaging Numbers, and Subsidiary Risk

You can edit the Labels Required field as
necessary. More than one label name will appear
here if more than one is listed in the UPS chemical
table. It is the shipper’s responsibility to ensure
that this field matches the labels that will appear
on the package. See Confirming the Labels
Required field for more information.

A brief list of exemption packaging numbers is
provided, but you can type any number there as
well. If the Exemption Packaging field is grayed
out, this means that no exemption is required by
UPS. You can override this, however, and enable
the field by selecting the Exemption Packaging
check box inside Setup.

Quantity and Unit of Measure (UOM)
Limitations

You can override quantity limitations and modify
the unit of measure on Ground shipments only.
You will see a warning message if the quantity
you enter exceeds what is listed in the table, but
you will be allowed to continue. To modify the unit
of measure, select an existing UOM from the list,
then simply type over it. Changing the printer driver
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Screen 8: Print and Save
Shipment Template

When you close the print preview window you will
see the Print and Save Shipment Template
screen. If you want to save this shipment as a
template, give the template a name and make
sure the Save as Template check box is selected
before you click Done. The Template Description
field is optional. Use it to provide additional
information about this shipment.
 
The template name you type here will now appear
in the drop-down list underneath <None> back in
the first screen, Shipment Template.

Figure 36: Select the Save as Template check box, name
your template, then click Done.

Changing the Emulation Mode on the printer
(tractor only)
Moving fields on the form
Increasing/decreasing point size of printed text
Setting the margins

Figure 34: Print Preview of the 8-part carbon shipping
paper.

Figure 35: Print Preview of the laser shipping form.

In the Print Preview you can:

•  Print your form by choosing Print from the File
   menu
•  Go to Page Setup to adjust margins
•  Open the Nudge tool to adjust fields on the form
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Printing the Hazardous
Materials Shipping Paper
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General Printing Overview

MASTERFORM prints two forms: the UPS
Hazardous Materials (hazmat) Shipping Paper
(on tractor or laser form) and the Shipper’s
Certification end-of-day log.

Form 1: Hazmat Shipping Paper
The hazmat shipping paper is available as an
8-part carbon form or as a single-sheet laser
form. Both forms are only available through UPS.

Form 2: Shipper’s Certification
The Shipper’s Certification is generated by
MASTERFORM and prints on plain, blank 81/2 x 11
inch paper. No special settings are required.
 
Printers
• If you use the 8-part carbon form for the hazmat

shipping paper, it is recommended that you use
two printers with MASTERFORM: a dot matrix for
the carbon form and a laser or inkjet printer for
the Shipper’s Certification.

• If you use the new single-sheet laser form, a
laser-jet printer is recommend. Inkjet and
bubble-jet printers are NOT recommended.

Labelmaster cannot support, endorse, or
recommend any printer. We have, however, used
certain Lexmark and Okidata printer models with
MASTERFORM and so we have provided special
instructions to help you use these models as well.
Look for special Lexmark and Okidata instructions
in the following sections of this book:

Changing the printer driver
Changing the Emulation Mode on the printer (tractor)
Printing gibberish or strange symbols
Printer feeds forms up too far
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Creating a custom paper size
(tractor)

Creating a custom paper size is only necessary if
you are using the 8-part carbon shipping paper
(i.e., the tractor form type). These instructions
do not apply to the Shipper’s Certification or the
single-sheet Shipping Paper (laser form type).

The Recommend button in the Configure Reports
dialog automatically creates the correct custom
paper size for Windows 95 and 98 users.
 
You can access the Configure Reports dialog by
entering Setup (the third icon in the main
MASTERFORM window) and clicking the icon for
either the Laser or Tractor UPS Approved Shipping
Paper shown under Configure Reports.
 
In the Configure Reports dialog, choose your dot
matrix printer from the drop down list and then
click the Recommend button. The paper size will
change to User-defined with dimensions of 8
inches in width and 4.67 inches in length. You can
also create a custom paper size manually through
Page Setup. The 4.67 length dimension is a
best-guess estimate. You may need to go slightly
shorter (4.5) or longer (5.0) to print correctly.
 
When you have created the custom paper size of
8 x 4.67 inches, it is recommended that you
change your printer driver to a model that can
read custom paper sizes. In some cases, you may
not be able to create a custom paper size until
you switch printer drivers first. Some printer
drivers do not accept custom paper sizes.

Installing a printer

If you are installing a printer for the first time to
use with MASTERFORM, follow these steps:
 
1. Attach the printer cable to the computer and

plug in the printer.

2. Install the printer driver: go to Start >
Settings > Printers.

3. Double-click the Add Printer icon in the
Printers window.

4. Follow the instructions in the Add Printer
wizard. Choose the manufacturer and model of
your printer when prompted unless you want
to use an alternative driver. See Changing the
printer driver.

Windows may prompt you to put your Windows
disc in the drive while installing a printer driver.
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To manually create a custom paper size
(Windows NT & 2000):

1. Go to Start > Settings > Printers.

2. Inside the Printers dialog, choose Server
Properties from the main File menu.

3. Check the box Create New Form.

4. Set the Width to 8 inches and the Height to
4.67 inches. (Left/Right, Top/Bottom margins
can be left at zero.)

5. Name your form and then click Save Form.

6. Go back to the MASTERFORM print preview
screen. With the print preview open, choose
Page Setup from the File menu and select the
Page tab.

7. Select the form size you have just made into
the Paper Size field as shown in Figure 38.

8. Click OK to exit and save your settings.
 
Warning! Windows NT users should read the
section in Troubleshooting, Custom paper size not
in paper size list.

To manually create a custom paper size
(Windows 95 & 98):

1. When you are at the print preview image of
your form and are ready to print, choose Page
Setup from the main File menu and then
select the Page tab.

2. Select the option Use Specific Printer.

3. Click the Printer button, then select the
correct printer from the drop-down list.

4. Click the Properties button.

5. Inside Properties, scroll to find the icon for
Custom. Double-click the Custom icon and
set the paper size to: Width 8 in, Height
4.67 in (800 / 467).

6.  Return to the Page tab and make sure the
Paper Size field reads User-defined.

7.  Click OK to exit and save your settings.

If you find that you cannot create a custom
paper size because the option to do so isn’t
enabled, follow the steps outlined in Changing the
Printer Driver and Changing the Emulation Mode
on the Printer before attempting to create a
custom paper size.
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Changing the printer driver

Right-click on the printer icon and choose
Properties from the pop-up menu. Click the New
Driver button (in the Details or General tab), then
select the new driver.
 
If your dot matrix printer (for the tractor form) is
one of the Lexmark or Okidata models listed
below, you can easily bypass the factory-set form
length on your printer by changing your printer
driver to an Epson model. This will eliminate the
need to manually shorten the form length on the
printer, saving you time and frustration. These
drivers read the paper size you specify in your
print setup configuration and save you the
trouble of changing the printer’s settings for each
document you print.

Suggested printer drivers:

Tractor
• Lexmark 2380/90x series: use the Epson FX 850
• Okidata 320/321x series: use the Epson FX 86E
• Okidata 520 or 590 series: use the Epson LQ 2550

Other drivers may work. These are just
suggestions to help you set up your printer.

Important! This list is not comprehensive and
there may be alternative drivers for your printer
that are not listed here. In fact, you may need
to try several drivers before you find one
that works. Contact your printer manufacturer
for alternative driver suggestions or other
information about printing custom form sizes on

Figure 37: Page Setup in Windows NT with a custom form
size named UPS hazmat.
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Changing the Emulation Mode
on the printer (tractor)

How do you know if you’re in the right mode? If
you get a series of symbols and strange
characters instead of words when you try to
print, it means your printer driver and your
Emulation Mode do not match.

When you change printer drivers, you must also
change the Emulation Mode on your printer.
Because you are now using an Epson driver, your
printer must be set to print in Epson Emulation.
Most non-Epson printers come pre-set to Lexmark
or IBM mode.
 
Emulation Mode is a function of the printer itself.
You cannot set Emulation Mode through Windows
or MASTERFORM. Refer to your printer manual or
call your printer’s technical support line for
instructions on changing emulation modes.
Instructions for 320x series printers are provided
here for your convenience.
 
To change the Emulation Mode on a Lexmark
238x or 239x series printer:

1. Press ALT + Setup at the same time to enter
the setup menu. The setup menu will print.

2. Press the Micro ?  (down arrow) button once.
The setup menu will print the Emulation op-
tions.

3. Press the Font button once. The setup menu
will print the IBM Emulation option.

your printer. Both http://www.lexmark.com and

 

To change to the Epson driver:

Go to Start > Settings > Printers (or Settings >
Control Panel and double-click the Printers icon)

From the Printers dialog, right-click your Lexmark
or Okidata printer icon and select Properties from
the popup menu. The printer properties will
appear. Under the Details tab (General tab for NT
users) you will see your current driver.

Click New Driver to select from a list of new
drivers. In the manufacturer list select Epson and
in the printer list choose the appropriate Epson
driver.
 
You may be prompted to put your Windows
CD-ROM in the drive while the driver change is
taking place.
 
Once you’ve switched to an Epson driver, you
must also change the Emulation Mode on the
printer to Epson Mode.

http://www.okidata.com provide drivers that you
can download for free.
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Setting the Margins

To set margins, choose Page Setup from the
main File menu and enter margin settings in the
Margins tab. You can only get to Page Setup from
the Print Preview of your form. [Margins can also
be changed following the steps in the section
MASTERFORM Setup.]

If you are using the tractor form:
Because every printer is different and every form
may be fed into the printer differently, there are
no standard margin settings. You will have to
experiment to find the correct margins. As a
general rule, however, the bottom and right
margins for MASTERFORM should be left at zero.
You will probably only need to adjust the top and
left margins.

If you are using the new laser form:
We recommend the following margin settings, but
you may have to adjust slightly depending on your
printer:

Top: 0.30"
Bottom: 0.20"
Left: 0.25"
Right: 0.25"

[These suggested margin settings were configured
for HP Laser Jet 6P/6MP-Standard laser printer
drivers. Other drivers may work; this is just a
suggestion to help you set up your printer.]

4. Press the Pitch button once. The setup menu
will print the Epson Emulation option.

5. Press Start/Stop repeatedly until the ALT
light stops blinking.

 
You want to keep this menu setting with the
Emulation set to Epson Mode. If you go through
these steps and still get symbols when you print,
perform the steps again being very careful to
press the Start/Stop button repeatedly until the
ALT light stops blinking (up to three times; the
printer will print menu options after each time you
hit the button).

To change the Emulation Mode on an Okidata
320/321:

1. Press SHIFT + SEL at the same time to enter
the setup menu.

2. Press LF. The following line will print:

Printer Control      Emulation Mode      IMB PPR

3. Press TEAR repeatedly until the emulation you
want to select prints in the right-hand column.

4. Press SHIFT + SEL to save this setting and
exit the setup menu.
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Moving fields on the form: use
the Nudge tool

You may sometimes need to make minor
adjustments to individual fields on the shipping
paper to get it to print correctly. Always try to
adjust your margins first, but if that doesn’t solve
the problem, use the Nudge tool (see Figure 38).

To access the Nudge tool, you must be in the
Print Preview of your form. Go through the wizard
and complete the shipping paper normally. When
you arrive at the Print Preview, choose Settings
from the View menu.

Figure 38: The Nudge tool.

If margin adjustments are not working for all fields
when you have printed, use the Nudge tool to
move field-specific information. (See Moving fields
on the form: use the Nudge tool.)

If your information prints too high…
…increase the top margin by the amount it is
away from the correct printing position.

If your information prints too low…
…and the top margin is set to its minimum value,
then your printer’s Top of Form (TOF) may not be
correctly set. Refer to your printer manual for help
setting your top of form. If your top margin is not
at its minimum setting, subtract the distance the
information needs to move to print correctly.
 
If your information prints too far to the left…
…increase the left margin by the distance the
information needs to move to print in the correct
position.

If your information prints too far to the right…
…and your left margin is set to its minimum value
then you need to reposition the printer’s tractor
feed further to the right. Refer to your printer
manual for help changing tractor positions.

If the left margin is not at its minimum value,
reduce the left margin to subtract the distance
that the information needs to move.
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The Nudge tool is only available when you are in
the Print Preview screen. You may access this by
clicking the Finish button when you come to the
end of the form-fill wizard. Print a form as a test
to see where the information lines up. Even if your
margins are set correctly, there may be a field
that needs adjustment.

Remember, if you have trouble getting the
information to line up correctly on the form and
find that you are nudging all or most of the fields,
you probably need to adjust your margins or the
settings on the printer itself. You should only have
to nudge a very small number of fields, if any.

“<default>” is the original setting for the
information. Some fields print incorrectly because
of slightly different printer configurations.

If you are using a laser printer, we recommend
print out a “practice” form on blank 8 1/2 x 11
inch paper on your initial printing attempt. By
holding your practice printout up to a UPS form
against the light, you c an check field alignment
and make necessary adjustments without using
the official forms.
 

To use the Nudge tool:

1. Click the New button and give a name to the
settings you are about to create. Then click
OK. If you want to save settings, you must
give them a name. (You cannot save over the
“<default>” setting, but you can save your
own settings as your personal default.)

2. Move the blue highlight to the field you want
to nudge by clicking the Next and Previous
buttons. The highlight will move around the
form in sequence (first number fields, then
text fields). By repeatedly clicking Next, you
will eventually go through each field on the
form.

3. Once highlighted, you can move the field
information by clicking the four directional
arrows. (If you make a mistake and want to
put the information back to its original
location, select <default> from the drop-down
list, or click Cancel to close the tool.)

4. Use the two A buttons to increase or
decrease the point size of the highlighted
information.

5. When the information is where you want it to
be, click Save. This will save this setting for
future use.

6. To delete a nudge setting, click the X!
button. It will confirm the name of the setting
you want to delete. Click Yes to delete, or No
to cancel.

7. Choose Print from the File menu to print the
shipping paper.
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Add or remove lines from the
printed form

You can put up to three materials on a shipping
paper and if you are using the 8-part carbon form,
MASTERFORM can print lines in between each
material on your shipping paper for clarity. If you
want lines between each material, make sure the
Print Data Only check box in Page Setup is not
selected.

When you come to the print preview of your form,
choose Page Setup from the File menu. Then
deselect the Print Data Only check box and click
OK.

Figure 11 on page 41 shows the Page Setup
window.

Increase or decrease the size
of printed text

Use the Nudge dialog to increase or decrease the
size of any individual portion of text:
 
1. Complete the form-fill wizard, provide all

required information, and arrive at the Print
Preview or Print and Save Shipment Template
screen.

2. If the Print Preview is not already loaded,
choose Print Preview from the File menu.
When the preview is loaded, open the Nudge
dialog by selecting Settings from the View
menu.

3. Click the New button and name the new
settings you are about to create. Click OK. If
you want to save settings, you must give
them a name. Delete a setting by selecting
the setting name and then clicking the Delete
button.

4. Move the highlight box to the field you want
to adjust by clicking the Next and Previous
buttons. The highlight will move around the
form in sequence.

 
Once the desired text field is highlighted, use the
two A buttons to increase or decrease the font
size of that text.
 
If you want to save the changes you have made,
click Save and name your settings.
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Printing the Shipper’s
Certification
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Printing the certification

To print the certification, double-click the
Shipper’s Certification icon at the beginning of the
program, select the date and the account number
you want, then click the Print button.
 
MASTERFORM compiles certification information
automatically based on the hazmat shipping
papers you print each day. This saves you the
trouble of retyping your daily shipment details for
the end-of-day log. Therefore, you can’t print a
certification without first creating shipping papers.
 
After you print a shipping paper, a message box
asks if you want to save this shipment to the
certification. When you choose Yes, MASTERFORM
saves this shipment information according to the
date and the UPS account number used.

To print a Shipper’s Certification:

1. Click the Shipper’s Certification icon on the
main MASTERFORM menu.

2. Select the date of the certification you want
to print from the drop-down list and then click
Next.

3. Select the appropriate UPS account number
from the drop-down list and then click Next.

4. Click either the print or print preview button.
You can print from the preview by choosing
Print from the File menu.
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Removing mistakes or
duplicates from the certification

You can prevent a mistake or duplicate shipment
from appearing on the Shipper’s Certification by
using the Void button on the Review Packages
screen right before you print.

To get to the Review Packages screen, click the
UPS Approved Shipper’s Certification icon on the
main MASTERFORM menu. Choose the date of the
shipment you want to void, then click Next.

Choose the account number in the Review
Packages screen. When all the shipments under
that account number appear, notice that the last
column, titled “Void,” says No for all shipments.
Highlight the line containing the shipment you
want to remove by clicking it once. With that
shipment highlighted, click Void. The Void column
for that shipment will now read Yes.

Click Next to continue and print the certification.
Void > Yes shipments will not appear on your
printout.

Saving shipments to the
certification

MASTERFORM automatically compiles Shipper’s
Certification end-of-day logs based on the hazmat
shipping papers you print each day. This saves
you the trouble of retyping or rewriting your daily
shipment details for the log book.
 
Save to Shipper’s Certification?
After you print a shipping paper, MASTERFORM will
ask if you want to save the shipment to the
certification:

When you choose Yes, MASTERFORM saves this
shipment information according to the date and
the UPS account number used. You would want to
choose No if this were a reprint, a test print, or a
mistake.

Say Yes to anything you want to appear on your
certification. If you make a mistake, you can void
materials off the certification later.

Figure 39: Choose Yes if you want to save the shipping
paper to the certification.
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Troubleshooting

Purge old certification records

If you’ve been using MASTERFORM for a while,
your archive of Shipper’s Certifications may be
getting too long. You can purge some of these
records by using the Purge Masterform Data
function.

Important! Make sure you keep printed copies of
all your certifications for billing and record-keeping
purposes. Once you purge these records, they will
be permanently deleted and you won’t be able to
get them back. See Printing the certification if
you need help reprinting your records before
purging.

To purge old certification records:

1. Select Purge Masterform Data from the View
menu.

2. From the list of dates, select the date of the
certification you want to delete.

3. Click Purge Data.
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Troubleshooting Overview

This chapter discusses some known issues and
common problems with MASTERFORM. If you
encounter an error message or problem, please go
through the following checklist before contacting
technical support.

• Can you recreate the problem consistently?
You should always save your work, reboot
your computer, and attempt to recreate the
error before contacting Technical Support.

• What version of MASTERFORM are you using?
Open MASTERFORM and choose About
Masterform from the Help menu to see your
version number. Have this number handy when
you call Technical Support.

• How did you install MASTERFORM? From a
CD-ROM? If so, which one? By downloading it
from the Labelmaster web site? If so, when did
you perform the download?

• What changed? Have you installed or
uninstalled anything lately? Has someone else
been working on your computer? Got a new
printer? Technical Support will need to know.

• What exact steps led to the error or problem?
Technical Support will need to know exactly
what you clicked or did before the error
occurred.

• What operating system, service packs, and
printer drivers do you have installed? These
things can affect MASTERFORM so Technical
Support may need to know.
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Printing gibberish or symbols

Symptom: When printing a shipping paper,
symbols print instead of words.

Cause: The Emulation Mode on the printer does
not match the printer driver being used. When
using an Epson printer driver, the Emulation Mode
on your printer must be set to Epson Mode.

Resolution/Workaround: Make sure the
Emulation Mode on the printer matches the printer
driver you are using. For example, if you are using
an Epson printer driver, your printer must be set
to “Epson Emulation Mode.” When you change
printer drivers, you must also change the
Emulation Mode on your printer.
 
Emulation Mode is a function of the printer itself.
You cannot set Emulation Mode through Windows
or MASTERFORM. Refer to your printer manual or
call your printer’s technical support line for
instructions on changing emulation modes. Review
Changing the Emulation Mode on the printer.

Account number not in the drop-down
list

Symptom: When you go to print out the
certification end-of-day log, no account numbers
appear in the drop-down list.

Cause: This problem occurs in the Review
Packages screen of the shipper’s certification
wizard. If there are no account numbers in the
drop-down list, it means that no shipping papers
have been printed yet. You cannot print a
certification before printing shipping papers
because MASTERFORM compiles the certification
automatically based on the shipping papers you
print.
 
Resolution/Workaround: Print the shipping
papers first, then print the certification. First,
make sure your UPS account number is entered in
Setup. Then, if you saved the missing
shipments as templates, reenter the templates
and reselect the UPS account number from the
dropdown list. Then reprint and choose Yes when
asked if you want to save this shipment to the
certification.

If you did not save the missing shipments as
templates, you will need to complete the shipping
paper again, taking care to select the UPS
account number from the dropdown list and
choose Yes when asked if you want to save this
shipment to the certification.
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Printer feeds forms up too far

Symptom: The shipping paper prints correctly on
the tractor form, but after printing, the printer
feeds up several more inches of paper before
quitting.

Cause: Usually this means that you do not have
a custom paper size correctly set. The UPS 8-part
carbon shipping paper is only about 5 inches long,
but most printers are defaulted to print an 11 inch
long page (standard letter size). Therefore when
you go to print, the printer feeds up the standard
11 inches.

Resolution/Workaround: To fix this, you must
create a custom paper size in Windows and make
sure your dot matrix printer can read it. See
Creating a custom paper size.

Custom paper size not in paper size
list

Symptom: Windows NT users create a custom
paper size, but it does not appear in the paper
size drop-down list in Page Setup.
 
Cause: This is a known conflict between
Microsoft Windows NT and the Epson FX-850
printer driver. It occurs when the height value of
the paper size changes while the width value
remains the same. It can also occur when the
width value is greater than 8.00 inches.

Sometimes Windows NT Print Manager cannot
show custom form sizes if the newly created form
has margin values greater than what the printer
driver has defined. This can happen even if the
printer is capable of handling the margins you
specify.
 
Resolution/Workaround: Use the Epson
LQ-1050 printer driver instead or make sure the
width value of the paper size is 8.00 inches or
below.
 
For more information on this problem, visit the
Microsoft Support web site
(http://support.microsoft.com) and look up the
following articles:

Article Number Q124733: Custom Forms Not Available for
Selection in Epson LQ-850

Article Number Q129531: Windows NT Print Manager and
Custom Form Limitations

Article Number Q108083: Custom Forms Not Available in
Print Manager

Shipper’s Certification prints on two
pages

Symptom: The Shipper’s Certification prints on
two pages, with the format not fitting the page.

Cause: Printing has been setup to print in portrait
orientation instead of landscape.

Resolution/Workaround: This can only be
changed by going through the Setup icon on the
main screen of MASTERFORM. In Setup, click the
UPS Approved Shipper’s Certification button under
Configure Reports. Click the Recommend button,
and it will switch orientation to Landscape. (Or, if
you have adjusted your own margins, you can
simply select Landscape under Orientation.) Click
OK to close the screen, then Done in Setup to save
the settings.
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Printer prints blank pages

Symptom: MASTERFORM prints out extra blank
pages.

Cause: Your margin settings are set too high.
If your margin settings are higher than the recom-
mended settings (see page 107), the program
may print additional blank pages.

Resolution/Workaround: To change your margin
settings, complete all package information in the
form-fill wizard as you would for generating a new
package. When you arrive at the print preview,
select Page Setup from the file menu.

After you have changed all four margins to the
recommended settings listed on page 107, go
back into Page Setup again under the file menu
to verify that the program saved your changes.

If your margins revert from what you changed
them to, your printer driver may not support a
margin setting small enough. To correct this
problem, you can try installing an alternative
driver by following the directions listed below:

1. Double-click the Add Printer icon in the
Printers window

2. Follow the instructions in the Add Printer
wizard. Choose HP from the list of printer
manufacturers and select the HP LaserJet
III driver from the list.

3. When done, select the correct printer
driver in MasterForm from clicking on the
Page tab from the Page Setup screen in
MasterForm. Click on Use Specific Printer,
and click the Printer button to select your
HP LaserJet III driver from the list, then
click on the Margins tab again to change
margins back to the recommended settings
on each side by following the directions
above.

Laser forms are not lining up properly

Symptom: When you print on the UPS laser
shipping form, the information does not line up
properly.

Cause: Your margins may not be set properly,
and/or the fields on the form may be adjusted to
print well on your printer.

Resolution/Workaround: For information on how
to adjust the margins, see the chapter entitled
Setting the Margins.

To adjust specific fields on the form, you will need
to use the Nudge tool. You can find instructions
on how to use the Nudge tool in the section titled
Moving fields on the form: use the Nudge tool.
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Can’t edit the PSN (proper shipping
name)

You can edit the proper shipping name in the
Proper Shipping Name screen, but only after you
have selected the material from the chemical
table. You must also select the Allow Proper
Shipping Name Edits option in Setup. See Editing
the Proper Shipping Name.

If you have covered both of these points and still
can’t edit, try refreshing the screen. Simply click
Next to move to the next screen, then
immediately click Back to return. Sometimes when
the Allow...Edits option is selected, the program
doesn’t register the new selection right away.
Refreshing the screen simply by moving in and out
of it will usually correct this.

Remember, you can’t edit anything in the
chemical table itself. You must make a selection
first, then edit.

Log book numbers are repeating

Symptom: The same log book number appears on
Certifications for more than one date.

Cause: N/A (Program functions as intended.)

Resolution/Workaround: The log book numbers
are supposed to roll over and begin repeating
after reaching a sequence of 100. An electronic
log book is 50 “pages” long, as counted by the
sequence number. Every MASTERFORM customer
receives two electronic log books for a total of
100 sequential pages. When your log book
reaches a sequence of 100, the sequence number
will reset itself back to one (1).

If UPS account representatives or accounting
personnel double-charge you for repeating log
book numbers, please have them contact
Labelmaster Software Technical Support. We will
put them in contact with management at United
Parcel Service who can clarify the issue with
them.

Remember, if you are shipping under multiple
accounts, you will see the same sequence number
go by for each account.

Also, the sequence number increments once per
day according to your computer’s system date. If
your system date has been tampered with, this
may affect the log numbers on your certification.

The text you entered isn’t an item on
the list

This error appears in the Shipper Information stage
of the form-fill wizard when you attempt to type a
new number in the UPS Account Number field.

You need to enter your UPS account number in
the Setup portion of MASTERFORM (accessible
from the icon on the main page) for it to appear in
the form-fill wizard. (See MASTERFORM Setup.)
Once you’ve entered your UPS account number in
the Setup Accounts section of Setup, your
account number will automatically be listed in the
drop-down box on the Shipper Information page.
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In UPS WorldShip®, the HAZMAT/DG
Reference list is grayed out

In UPS WorldShip®, the HAZMAT/DG
Reference list is blank

Symptom: In UPS WorldShip, in the area called
Package Options, the box for HAZMAT/DG is
grayed out.

Cause: If the database has been setup correctly,
it is mostly likely that WorldShip has been installed
recently and your account is not yet in the
WorldShip system.

Resolution/Workaround: First double-check to
verify that your database has been setup cor-
rectly (see page 21 for further information). If
your database is setup correctly, you will need to
wait at least 48 hours after installing the
WorldShip program before UPS enables the
HAZMAT/DG option.

If you continue to have problems, or need more
information on WorldShip, contact UPS OnLine
WorldShip Help at 1-888-553-1118.

Symptom: In UPS WorldShip, the HAZMAT/DG
Reference list field is blank.

Cause: After completing the form-fill wizard in
MASTERFORM for UPS and printing out your
shipping form, you didn’t save your shipment to
Shipper’s Certification.

Resolution/Workaround: You must first
complete all the information for the UPS approved
shipping paper and print out the form. A prompt
will then ask if you would like to save the
information to the Shipper’s Certification. Say
Yes. Until you do, the HAZMAT/DG Reference
list will be blank.
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To see the shortcut path, right-click the
MASTERFORM icon on your desktop and choose
Properties from the pop-up menu. Click the
Shortcut tab and check the path in the Target
field.

If the shortcut path is incorrect or if databases
have been moved, you may need to reinstall
MASTERFORM. See Managing Templates and
Addresses before you reinstall.

If the shortcut path and installation directory are
correct, a database may be corrupt. You can
e-mail the database to Technical Support to be
repaired, or you can reinstall MASTERFORM. If you
are concerned about saving your templates or
addresses, be sure to read Managing Templates
and Addresses before you reinstall.

Unexpected error occured in
subsystem...

Symptom: Upon opening MASTERFORM, the
following error occurs: “Unexpected error
occurred in subsystem link tables from db...”

Cause: MASTERFORM can’t find the databases it
needs to run or those databases are corrupt.

Resolution/Workaround: First, make sure your
MASTERFORM installation files are all in the same
place. This error can occur if the Masterform.mdb
or UPSChemical.mdb files have been moved out of
the installation directory or renamed. Find your
installation directory, which is C:\MF_UPS by
default, and see what Microsoft Access database
(*.mdb) files are there. You should see:

Exchange.mdb
masterform.mdb
mf_v20s.mdb
UPSChemical.mdb

If any of these are missing or incorrectly named,
call Technical Support at 1-800-578-4955.

Second, make sure your MASTERFORM desktop
shortcut is pointing to the correct directory. By
default, your shortcut path should look like this
(all one line):

C:\MF_UPS\Msaccess.exe  /runtime  /profile
“MASTERFORM by Labelmaster”  /wrkgrp
“C:\MF_UPS\ups.mdw”
“C:\MF_UPS\MF_v20s.mdb”
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Do you want to convert or enable the
database?

Symptom: When you open MASTERFORM, you
receive a message box asking if you would like to
convert or enable the database.

Cause: This happens when you attempt to run an
Access 97 run time application on a computer
that has an early version of Office 2000 installed.

Resolution/Workaround: Microsoft addressed
this issue in an Office 2000 service pack. To
resolve the issue, you must go to the Microsoft
support site and download the latest Office 2000
Service Pack. (http://support.microsoft.com)

Run Time Error 9 in Configure Reports

Symptom: When you click a Configure Reports
report icon, you encounter a Run Time Error 9 and
cannot continue.

Cause: This is a known issue between Microsoft
Access and Hewlett Packard. It sometimes occurs
when you have an HP printer set as your default
printer.

Resolution/Workaround: To work around this
issue, set any other printer to be your default
(even adding a new, non-existent printer if
necessary) just long enough to get into Page
Setup or Configure Reports and complete your
settings. The default printer must not be a
Hewlett Packard. When you are finished, you can
reset the Hewlett Packard back to the default
printer.

Sometimes just changing the default printer isn’t
enough. You may need to delete your HP printer
altogether and then re-add it after you have
configured MASTERFORM.

Remember that Configure Reports is just a
shortcut to Page Setup. You may be able to enter
Page Setup at the end of the wizard (from the
Print Preview screen) and make all your setting
changes there.
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While printing a long Certification,
some pages print correctly and others
come out garbled

Symptom: You are printing a several-page long
Shipper’s Certification end-of-day log. The first
several pages are fine, but later pages start
coming out garbled.

Cause: This may be caused by too much
information being spooled to the printer driver.
Garbled text is usually an indication of driver
failure.

Resolution/Workaround: To work around this
issue, use the Void function of the Review
Packages screen to reduce the number of records
printing at one time.

For example, if you had 40 shipment records on
the Certification, void off the first 20
(approximately half of your shipments) and then
print. This smaller number of records should print
correctly. Then go back and void the records you
just printed and unvoid the ones you have not
printed. Now print the remaining 20 records.

All the shipments will still appear with the same
log book number and date, and you have avoided
the driver problem by sending less data to the
printer.

See the chapter Printing the Certification for
instructions on using the Void function.

You do not have a license with
MS Access

Symptom: When you open MASTERFORM, you
receive a message box saying you do not have a
license with Microsoft Access.

Cause: This happens when you attempt to run an
Access 97 run time application on a computer
that has Office 2000 installed.

Resolution/Workaround: Microsoft addressed
this issue in an Office 2000 service pack. To
resolve the issue, you must go to the Microsoft
support site and download the latest Office 2000
Service Pack. (http://support.microsoft.com)
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After deleting the MF_UPS folder, it’s a good idea
to empty your Recycle Bin and reboot your
computer. This ensures that the program files are
permanently deleted and the hard drive space
they had occupied is free to be used by
something else.

By default, MASTERFORM for UPS installs to the
MF_UPS folder on the C:\ drive, but you may
have chosen to install on a different drive.
Regardless of where you installed MASTERFORM,
you should double-check the location to make
sure that the folder is gone. You may also need to
manually delete the desktop icon.

Uninstalling MASTERFORM

Before you uninstall...
Uninstalling and deleting directories will
permanently delete your templates and addresses
unless you manually save the databases that
store them beforehand. If you want to save your
templates and addresses, you can do so by
saving a copy of the appropriate database files
before uninstalling.

MASTERFORM for UPS Domestic Edition templates
are stored in the file named masterform.mdb.
Addresses are stored in the file named
Exchange.mdb. Both of these files will be in your
installation directory, which by default is
C:\MF_UPS. See Managing Templates and
Addresses for more information.

To uninstall MASTERFORM:

1. Perform a standard uninstall:  Go to Start >
Settings > Control Panel > Add/Remove
Programs. Highlight MASTERFORM in the list
of programs and click Remove.

2. Delete any remaining program files: When the
standard uninstall is finished, browse through
your hard drive using My Computer or File
Manager and look for left-behind program
folders. Uninstalling often leaves some files
behind.
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Grant of License: In consideration of your
subscription fee, Labelmaster Software, AN
AMERICAN LABELMARK COMPANY grants to you a
non-exclusive, non-transferable license to use the
Software for the duration of your paid and active
subscription on a SINGLE COMPUTER UNLESS
INDICATED DIFFERENTLY IN WRITING BY
Labelmaster Software, AN AMERICAN LABELMARK
COMPANY.

If at the end of your subscription period, should
you choose not to renew your subscription with
Labelmaster Software, AN AMERICAN LABELMARK
COMPANY, this license and your ability to use this
software and updates ends. You must place the
same copyright and other proprietary rights
notices on any copy of the Software as appears
on the original.

You must not transfer, sell, assign, rent or
distribute any copies of the Software to others.
Labelmaster Software, AN AMERICAN LABELMARK
COMPANY reserves the rights not expressly
granted to you.

Proprietary Rights: The Software is copyrighted
by and proprietary to Labelmaster Software, AN
AMERICAN LABELMARK COMPANY, and its
suppliers. Labelmaster Software, AN AMERICAN
LABELMARK COMPANY AND ITS SUPPLIERS retain
titles and ownership of all copies of the Software.

The non-exclusive license set forth in this
Agreement is not a sale of the Software or any
copy. You agree to hold the Software in
confidence and to take all reasonable steps to
prevent unauthorized disclosure. It is also
understood that the Software contains public
information. Public information in this Labelmaster

License Agreement

Below is the license agreement you confirmed
when you installed MASTERFORM. If you have any
questions, please contact the Labelmaster
Software Sales Manager at 1-800-578-4955.

USER LICENSE AGREEMENT FOR LABELMASTER
SOFTWARE PRODUCTS, AN AMERICAN
LABELMARK COMPANY

NOTICE TO USER: DO NOT CONTINUE UNTIL YOU
HAVE READ THIS AGREEMENT

Our Software license is displayed on this install
program so you could read it before continuing
the installation of this subscription. DO NOT
CONTINUE installing this program until you have
carefully read this agreement.

BY CONTINUING THIS INSTALLATION YOU ACCEPT
ALL THE TERMS AND CONDITIONS OF THIS
AGREEMENT.

If you do not agree with the terms and conditions
of this agreement, continue to the next screen,
exit and promptly return the package, uninstalled,
to your supplier for a full refund.

In return for acquiring a license to use the
Labelmaster Software, AN AMERICAN LABELMARK
COMPANY, subscription Software product
(“Software”), which includes this license
agreement as an integral part therefore, you
agree to the following terms and conditions:
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right to terminate your license immediately if you
fail to comply with any term or condition of this
Agreement. Upon any termination you must
destroy the Software together with all copies or
modification in any form.

Limited Warranty: Labelmaster Software, AN
LABELMARK COMPANY guarantees you complete
satisfaction with the Software during the 30-day
period following the date you first receive it. At
any time during that 30-day period you, at your
sole option, may return the total contents of the
original package for a full refund (less shipping and
handling charges, if any where applied to the
original order).

In addition, you must provide Labelmaster
Software, AN AMERICAN LABELMARK COMPANY,
with a written description of what caused your
dissatisfaction with the Software. If you exercise
this option, you must destroy any duplicate
copies of the contents of the Software before
you request a refund. Unless Labelmaster
Software, AN AMERICAN LABELMARK COMPANY,
has received the complete package and written
notice as described above within 7 days after the
end of the 30-day period, you will be treated as
having fully examined and accepted the Software
and conclude that the Software is satisfactory to
you in every respect.

Labelmaster Software, AN AMERICAN LABELMARK
COMPANY, DOES NOT WARRANT THE PERFOR-
MANCE OR RESULTS YOU MAY OBTAIN BY USING
THE SOFTWARE. THE FOREGOING STATES THE
SOLE AND EXCLUSIVE REMEDIES LABELMASTER
SOFTWARE, AN AMERICAN LABELMARK COMPANY,
WILL PROVIDE FOR BREACH OF WARRANTY. YOU
UNDERSTAND THAT, EXCEPT FOR A 30-DAY

Software, AN AMERICAN LABELMARK COMPANY,
publication is not included under the copyright
laws. The public information in this Labelmaster
Software, AN AMERICAN LABELMARK COMPANY,
publication does contain proprietary formatting
and information that is not public information.

In consideration of the subscription fees,
Labelmaster Software, AN AMERICAN LABELMARK
COMPANY grants you the right to print, copy or
transfer electronically the text of the Software for
your own personal use provided the proprietary
formatting or information is not used or included in
any and all electronic COMPUTER BASED
publications that you may make commercially
available.

No Other Rights: Except as stated above, this
Agreement does not grant you any rights to
patents, copyrights, trade secrets, trade names,
trademarks (whether registered or unregistered),
or any other rights, franchises or licenses in
respect of the Software. YOU MAY NOT MODIFY,
TRANSLATE, DISASSEMBLE, OR DECOMPILE THE
SOFTWARE OR ANY COPY, IN WHOLE OR IN PART.
YOU ARE EXPRESSLY FORBIDDEN TO DOWNLOAD
OR INCORPORATE ANY OF THE PROPRIETARY
FORMATTING AND/OR INFORMATION PROVIDED IN
THIS LABELMASTER SOFTWARE, AN AMERICAN
LABELMARK COMPANY, PUBLICATION FOR ANY AND
ALL ELECTRONIC COMPUTER BASED PUBLICTIONS
THAT YOU MAY MAKE COMMERCIALLY AVAILABLE.

Term: The license is effective until terminated.
You may terminate the license at any time by
destroying the Software (including the related
documentation) together with all copies or
modification in any form. Labelmaster Software,
AN AMERICAN LABELMARK COMPANY, will have the
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Choice of Law: This Agreement will be governed
by the laws of the State of Washington as applied
to transactions taking place wholly within
Washington between Washington residents.

U.S. Government Restricted Rights Legend:
Use, duplication, reproduction or disclosure by the
Government is subject to restrictions in
subdivision (c)(l)(ii) of the Rights of Technical
Data and Computer Software Clause at 48 CFR
252-227-7013 and in subparagraph (a) through
(d) of the Commercial Software - Restricted
Rights Clause at 48 CFR 52-227-19 and the
limitations set forth in the Labelmaster Software,
AN AMERICAN LABELMARK COMPANY, standard
commercial Agreement for Software. Unpublished
rights reserved under the copyright laws of the
United States.

Integration: You acknowledge that you have
read this Agreement, understand it, and that by
opening the package you agree to be bound by its
terms and conditions. You further agree that it is
the complete and exclusive statement of the
Agreement between Labelmaster Software, AN
AMERICAN LABELMARK COMPANY, and that it
supersedes any proposal or prior agreement, oral
or written, and any other communications
between Labelmaster Software, AN AMERICAN
LABELMARK COMPANY, and you relating to the
subject matter of this Agreement.

No variation of the terms of this Agreement or any
different terms will be enforceable against
Labelmaster Software, AN AMERICAN LABELMARK
COMPANY, unless Labelmaster Software, AN
AMERICAN LABELMARK COMPANY, gives its express
consent, including an express waiver of the terms
of this Agreement, in writing signed by an officer

LIMITED WARRANTY, LABELMASTER SOFTWARE,
AN AMERICAN LABELMARK COMPANY, MAKES NO
WARRANTIES, EXPRESS OR IMPLIED, AS TO
PERFORMANCE, NON-INFRINGMENT OF THIRD
PARTY RIGHTS, MERCHANT-ABILITY OR FITNESS
FOR ANY PARTICULAR PURPOSE.

Some states do not allow the exclusion of implied
warranties or limitations on how long an implied
warranty may last, so the above limitation may
not apply to you. This warranty gives you specific
legal rights and you may also have other rights
which vary from state to state.

Limit of Liability: IN NO EVENT WILL
LABELMASTER SOFTWARE, AN AMERICAN
LABELMARK COMPANY, BE LIABLE TO YOU FOR
ANY SPECIAL DAMAGES. INCLUDING ANY LOST
PROFITS, LOST SAVINGS OR OTHER INCIDENTAL
OR CONSEQUENTIAL DAMAGES, EVEN IF
LABELMASTER SOFTWARE, AN AMERICAN
LABELMARK COMPANY, OR ANY REPRESENTATIVE
HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH
DAMAGES, OR FOR ANY CLAIM BY ANY OTHER
PARTY.

Some states do not allow the exclusion or limita-
tion of consequential damages, so the above
limitation or exclusion may not apply to you.

Export: You acknowledge that the laws and
regulations of the United States restrict the
export and re-export (as defined in section 379.1,
(b)-(c)) of the export Administration Regulations
and any amendment thereto of the Software. You
agree that you will not export or re-export the
Software or media in any form without the
appropriate United States and foreign government
approval.
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Index

A
Access  69
Account Number  41, 124
adding users  47, 48
Address Book  67, 69, 75
Administration  17, 47, 48
air  87, 90
Allow Proper Shipping Name Edits  43
amount  90

B
Basic Description  89
bubble-jet printer  97
Bypass Authorization Screen  18, 42

C
changing information  57, 99, 103, 105
changing font/point size  109, 112
changing printer drivers  103
chemical table  34
Chemical Table screen  89
choose options  42
Clear Default  78
Code of Federal Regulations  13
Configure Reports  42, 99
Contact information  31
creating a custom paper size  99

D
databases  36
Date field  86

of Labelmaster Software, AN AMERICAN
LABELMARK COMPANY.

Should you have any questions concerning this
Agreement, please contact us in writing at:

Labelmaster Software
Attn: Sales Manager
400 East Pine Street, Suite 210
Seattle, WA 98122

Toll Free Phone: 1-800-578-4955
E-mail: softwaresales@labelmaster.com
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H
Hardware Recommendations  33
hazmat hotline  32
hazmat shipping paper  97
HM 215-D  13
how to print  97
HP laser printers  103, 108

I
I.D. Number  89
importing addresses  69
inkjet printers  97
install printer  98
installation directory  18
installing  MASTERFORM 15
installing a printer  98
International  17

L
Labels Required  59
laser printers  19, 97
Lexmark  97, 103, 105
License Agreement  142
Limit of Liability  146
Limited Warranty  145
lines  113
log book number  49
look up  89

M
magnifying glass icon  87
margin settings  107
Microsoft Support web site  126
Military Edition Suite  15
moving fields  109
multiple field values  79
multiple UPS accounts  44

default field values  78
deleting templates  53
demo version  15
Domestic  17
dot matrix  97

E
editing  57
emergency contact phone  86
Emulation Mode  105
Epson drivers  104
Epson FX-850  126
error message  123
Excel  69
Exchange.mdb  70
Exemption Packaging  43
exporting addresses  75
ExportWS.mdb  24

F
file extensions  37
Finish button  91
font (point) size  112
form size  99
forms, ordering  19
forms, printing  91
forms to use  97

G
garbled text  139
gibberish  125
Grant of License  143
graphics  113
ground  87, 90
Ground or Air Shipment screen  90
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Q
quantity limitations  89, 90

R
receiver city  86
receiver name  86
receiver state  86
Recommend  42
reducing  99
registered trademark  4
regulations  80
Remember  79
remove lines  113
Research and Special Programs Administration  32
review form  91
Review Packages  119
RSPA  32
rules  89
Run Time Error  136

S
Save template by default  43
Security  47
service pack  137
Set Default  78
Setup  41
Shipment Information screen  86
Shipment Template screen  85
Shipper Information screen  86
shipper name  86
Shipper’s Certification  97, 118, 127
shortcut path  134
shortening  99
signature  86
Subsidiary Risk  90
Supervisor  48
support  31

N
NAID  89
new driver  97, 103
notes  65
Nudge tool  92, 109

O
ODBC Data Source Administrator  22
Office 2000  137
Okidata  97, 103, 106
online demo  31
online training  31
Options (Setup)  42
Other Required Information  86

P
Package Label Warning  42
package reference  86
packaging provisions  89
Page Setup  107
page size  99
paper size  99
passenger or cargo  86
password protection  18,  47
pre-print  61
Print Ahead Mode  43,  61
Print Data Only  113
Print Preview  91, 92
Print Setup  107
printers  91, 97, 98, 105
printer drivers  97, 103
printer functions  105
printer properties  103
printing  91, 92, 97
Professional Edition Suite  15
Proper Shipping Name  57, 87-88, 89
Proprietary Rights  143
purge old records  120
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symbols  125
system DSN  20
system requirements  33

T
Technical Name  87
technical support  31
templates  51-57
text  113
tractor forms  107
training  31
Transport Mode  86
Transportation Safety Institute (TSI)  16
troubleshooting  121
TSI Hazmat Training program  16

U
U.S. Department of Transportation  32
unauthorized  47
UNID  89
uninstalling  140
Unit of Measure  90
UOM  90
UPS account number  86
UPS Chemical Table  15
UPS service  86
UPS WorldShip  20
US DOT  32
user names  17, 47

V
view form  91
Void  119

W
warning  60
weight  90
Windows 95  100
Windows NT  101
WorldShip  20
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